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Host Links for Windows
Installation
This manual describes installation and configuration of the Windows version of
the product set.

Host Links product overview
Terminal environment
Host links products that run on UNIX or Linux servers with a terminal driven
user interface include emulators and concentrators, as well as various utilities.
•

G3270

provides synchronous IBM3270 functionality. G3270 emulates
IBM LU type 2, including base and extended colour together with
extended highlighting.

•

Qsim

provides synchronous Questar terminal functionality. Qsim
simulates all Questar models, including the DKU7007,
DKU7107, DKU7105 and DKU7211 (Mono, four colour A/B
and seven colour modes are supported). It also simulates the
VIP7760 and the VIP7700.

•

V78sim

provides Bull VIP78xx (BDS) functionality. V78sim emulates all
models of the VIP7800 family; the actual reference is the BDS7.
All visual attributes including colour are supported.

•

Pthru

provides transparent VIP7800 visibility to Bull mainframes for
users with asynchronous VIP7800 terminals or emulators. The
terminals are used in text or forms mode.
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Server environment
Host Links products that run on UNIX, Linux or Windows servers.

2

• Ggate

is a transparent gateway to the Bull native network. It avoids all
need for Front-ends (MainWay/Datanet) or other gateways. It can
be used to connect G&R/Glink (for Windows or Java) emulators
or any of the emulators, concentrators, network printer emulators
and file transfer clients/servers in the Host Links product set. It
also supports third party clients using the Bull TNVIP and
standard asynchronous Telnet protocols.

• Gweb

provides a web browser interface to any host application that is
otherwise accessible using the Host Links Qsim, V78sim,
or G3270 emulations.

• Gspool

is designed to run as an unattended process and accept
transparent print output from any type of host application
(GCOS8, GCOS7, GCOS6, IBM) that normally sends print data
to network printers (ROPs), or to a remote spooling system
(DPF8-DS). On the Gspool system the print may be directed to a
physical printer or to the local spooling system. Gspool operates
in different modes, Connect mode, Terminal Writer mode, DPF8
mode, SNM mode, IBM mode, TN3270 mode and TN3270E
mode.

• GUFT

is an implementation of the Bull UFT file transfer protocols. These
protocols enable transfer of data files between heterogeneous
systems. The systems must be interconnected in a DSA/OSI
network running over a private or public X25 network or over a
local area network (LAN).

• Gproxy

is a network management program used for supervision,
management, load balancing and license sharing of G&R Host
Links applications. Gproxy can be set up as a freestanding
monitor program and/or report generator in a small network, or
play a bigger role in a larger network.

• Gsftp

is a transparent gateway between two different File Transfer
protocols: FTP (RFC 959) and SFTP (the SSH File Transfer
Protocol). The purpose is to present a seamless integration
between the two protocols, with automatic conversion.
Host Links Installation and Configuration
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Functional summary
The G&R Host Links products transform any server platform into a native DSA
or DSA/ISO Workstation (DIWS) node in the Bull primary network, or into a
3270 cluster within SNA. Communication between the Host Links system and
the Bull systems is generally done using the Bull DSA session protocol.
Communications with IBM systems is by TN3270/TN5250.
The DSA connections can be made in the traditional way using OSI-transport,
which is a requirement when connecting via old-style Datanets. The Bull
systems can be accessed over an X.25 WAN or Ethernet LAN through a
Datanet or MainWay front-end. Alternatively access can be direct to GCOS6
using a LAN adapter or direct to GCOS7 using ISL. Access can be by an FDDI
LAN direct to GCOS7 using FCP7 or direct to GCOS8 using FCP8.
The DSA connections can also be made over a TCP/IP network, using the
Internet standard RFC1006 transport protocol to replace OSI-transport.
MainWay front-ends with an ONP (Open Network Processor) have RFC1006
support in the standard product, allowing DSA sessions over TCP/IP into the
MainWay. RFC1006 can also be installed in the FCP7 and FCP8 cards to
support DSA connections direct to the hosts without passing through the frontend. The GNSP on newer GCOS8 systems accepts DSA/RFC1006 connections,
as does the newer GCOS7 Diane systems. G&R Host Links systems are
qualified with both.
The Ggate product may be used to off-load the DSA session protocol into
gateways. By running Ggate on the system(s) with the host connections all
other PCs, Macintoshes, Windows and UNIX machines in your network need
only the very small and efficient Ggate protocol layer to connect over TCP/IP
to a Ggate gateway with full primary network functionality. Ggate can make
the host connection using OSI-transport or RFC1006. If you must use OSItransport for the host connection, using Ggate will limit the need for OSI-stacks
to the Ggate platforms.
IBM systems can also be accessed using Telnet 3270 (TN3270 or TN3270E) to
connect to any TN3270ÙSNA gateway or front-end. The MainWay gateway,
the TN3270 server on the Bull DPX/20 UNIX systems, the IBM TN3270 frontend and the TN3270 server for Windows are all qualified.
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Bull systems can also be accessed using Telnet VIP (TNVIP). The TNVIP
servers in the MainWay and in the Bull DPX/20 are both qualified. However,
RFC1006 is supported in the MainWay front-ends with an ONP (Open
Network Processor), and if used when communicating with G&R products it
will increase throughput as compared to using TNVIP. It will also give a real,
fully functional DSA or DIWS session over the TCP/IP network, as compared
to the limited terminal session offered by TNVIP.

4
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Product architecture
The Windows versions of the G&R products are built in a modular way, and
designed to take advantage of the multitasking capability of the Windows
platform. Thus a single instance of a product will in general consist of two quite
separate processes, communicating with each other using pipes and shared
memory:
• A product; for example a print spooling server which accepts incoming
connections from a host or client system and converts print commands
to native Windows printing instructions. The print spooler will receive
print data from the host system using the standard interface that applies
to all communications protocols.
• A line handler; which maps the standard format for communications into
the specific line protocol being used.
This structure has proven itself extremely efficient and very robust. We are able
to develop a new line handler and know that once it works with one product it
will work with all. We are able to develop a new product using a given
communications protocol, and know that the product will work with all the
communications protocols we support.
Some of the programs in the Basic product, such as GmonitorW, differ slightly
as they don’t need a line handler; they only have a Windows interface.
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Architecture diagram
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Delivery
Files
Host Links products for Windows are delivered as an executable self-extracting
archive. We deliver several different installation sets, containing different Host
Links products. The name of the executable reflects the Host Links version,
hardware platform and products included. e.g.:
386pc_640en_HostLinks.exe
x64pc_640en_HostLinks.exe
i64pc_640en_HostLinks.exe

Host Links version 6.4.0 (English) for 32
bits (IA32) processors
Host Links version 6.4.0 (English) for 64
bits AMD x86_64 processors
Host Links version 6.4.0 (English) for 64
bits IA64/Itanium processors

The platforms supported in any release are as stated in the SRB (Software
Release Bulletin) for the release.

License
All G&R products require a license key. You should have received the license
keys from your distributor together with the software. The licenses are stored in
text format in a file named licenses.
If "licenses" is delivered with the product files you can pick it up when
requested during the installation procedure. You can also copy it into your
configuration after installation. The location is:
Windows server

Gallagher & Robertson
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General requirements
Real memory
The sizes of the Windows kernel and the OSI stack (if used) are not included in
these figures.
Program

Program size

Per session

Nl_dsa

2000 KB

80 KB

Ggate

1500 KB

Gproxy

1500 KB

Gspool

550 KB

GUFTsrv

1650 KB

Gweb

1700 KB

Each Ggate session consists of one instance of the nl_dsa program.
An example: Suppose you have a machine that needs to support 200 Ggate
users over DSA. All results below are in MB (= 1000 KB).
Nl_dsa

2.0

Ggate

1.5

200 sessions

16.0

Windows kernel

12.0

Standard Windows servers ¹

10.0

OSI stack 200 sessions
Total RAM needed

8
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Installation step by step
Preparation
Copy the installation package and license
Copy the installation package to a temporary directory (e.g. c:\hlinstal)
on your Windows system. It is used only during installation and can be
removed afterwards. For convenience copy the licenses file to the same
directory.

Create user gar
Before installing Host Links or any of its associated software, such as the OSItransport stack, you should create a user for administration of the Host Links
software. Create a new user gar on your Windows system. This user should be
a member of the 'Administrators' group.

Disable Marben OSIAM transport if used
If you use the Marben stack stop it in the Services Control Panel and set its
start-up mode to Disabled. If you move to RFC1006 (highly recommended)
you can uninstall it later. If you continue to use the Marben stack you might
need to upgrade it. This is described in the section entitled Marben OSIAM
transport.

Log out, then in again as gar
Log out, and then log in again as gar before continuing with the rest of the
installation.
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Disable old Host Links releases
Remove any old Host Links system directories from your search path (in the
System Control Panel).

Stop and Disable running servers
If you have Host Links 6.0 or later installed:
Use the Gmanager program gmanw.exe to stop all running servers.

If you have Host Links 5.x installed:
Using the Gservice configuration program gservice.exe, stop
Gservice if it's already installed and running; set its startup mode to
Manual and click Modify. Gservice can also be stopped with the
following command line via the Run menu or a DOS box:
net

stop

gservice

Also remember to close all running Host Links programs (Gmanager,
Gconfig, Gdir etc.) before continuing with the installation!

Installation
The default system directory for Gallagher & Robertson products is:
Windows

c:\gar

During installation you are given the choice of installing on a different
directory. If you have an old version of Host Links installed this will be
detected, and you can install in the previously used system directory.
The installation program does not overwrite configuration files that you have
changed at your site. Sample files will be installed in the configuration
directory but will use the release number (640) as an extension, rather than
.cfg or .htm. The exception is Gweb sample HTML files. If you have
modified the sample files from a previous release and still use their original
names, you should make a back-up copy of them before installing Gweb.

10
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Run the Host Links distribution executable.
The Host Links package first extracts the installation files in order to run the
installation program:

Select “Extract” to start extracting the installation files and launch the
installation program:
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The installation program will begin by presenting you the contents of the
install.1st file, which contains information about preparing your server for
the specific packages you are about to install. Read this text carefully before
continuing with the installation, as the software may install incorrectly if you
have not prepared your server beforehand!

Select Next to continue the installation.

The destination directory becomes your Host Links System directory and is
required. We recommend that you accept C:\GAR as the destination directory,
because the Host Links documentation often assumes this to be your System
directory when describing configuration files and examples on how to start
Host Links products. If the destination directory does not exist you will be
asked if you want to create it.
12
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You are given the choice between a full installation of all the supplied packages
or a custom installation:

Selecting Custom installation allows you to select only the products you have
licensed and reduces disk space usage. It also avoids warnings about missing
product licenses at the end of the installation when the installed products are
verified against your licenses file,

Select only the products to be installed, then click Next:
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Enter the path of your licenses file, or use the browse button to select the
file from its location in the file system. If you do not have a licenses file
leave this field empty. Continue by clicking Next.

During the installation a folder with program icons for the most common
programs is created and placed in the Start Menu. This folder can either be
available for all users on the server, or just the user logged in when installing
Host Links. Note that in a real server installation the user installing Host Links
should be gar. Select the option you need and click Next.

14
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The default name of the folder with Host Links icons is G&R software. Keep
it as it is or change it to something more appropriate for your installation.
You are now ready to start the Host Links software installation, which copies
the software files to their destination directories, updates the registry and
creates program icons in the start menu.

Click Install to start the process.

Gallagher & Robertson
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When all the files have been installed, the install program displays a list of
release information files and a text box where these can be viewed. Please
review this information before continuing.

Click Close to finish the installation. By default Gmanager and the Host Links
program group are loaded.

16
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Running Gmanager for the first time
When you run Gmanager for the first time it requires that you install and
configure Gservice on the system Gmanager monitors this process. First it
displays a dialog box asking for the system name.

Click OK to keep the default choice (the local system name) and continue.
Gmanager detects that Gservice is not installed on this system and offers to
configure it.

Click Yes to configure Gservice on the local system.

Gallagher & Robertson
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The user name field suggested should be the same user as you are currently
using to install Host Links. Enter the password and click Add. It confirms the
modification:

Set the path
If you intend to run Host Links programs from the command line prompt you
should add the new Host Links binary directory (by default C:\GAR\BIN32)
to the system search path in the Control Panel. Select the System icon, then
Advanced and Environment Variables.

18
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DSA network configuration
If you are installing only Gweb with a TNVIP or TN3270 interface, or only a
Glink for Java server you can skip to the section entitled Configure Host
Links servers. If you are installing Ggate, GUFT or other products that
communicate with Bull mainframes then you must configure the DSA network.

Install the network software
The G&R communications products for accessing the Bull primary network use
DSA session protocol. The session protocol is delivered by G&R, but requires a
transport interface on the Windows platform.

RFC1006
If your Bull mainframe has RFC1006 then no more communications software is
required. We include RFC1006 in Host Links. Bull mainframes with RFC1006
include all systems using an FCP card, systems with a MainWay Front-end,
GCOS8 Helios systems, GCOS8 Olympus systems and GCOS7 Diane systems.

OSI-transport
If your Bull mainframe does not have RFC1006 installed, or if you choose not
to use it, you will need an OSI-transport stack. G&R supply and support the
separately priced Marben OSIAM transport stack for use with Host Links. It
must be installed and configured. Please refer to the section entitled Installing
and configuring the Marben OSIAM stack and install the stack before
continuing.

Gallagher & Robertson
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DSA network configuration
After installation you must configure the DSA network. You can work directly
on the DSA configuration file:
c:\gar\config\dsa.cfg

An easier way to do this is with the Configuration wizard included in
Gmanager:

This wizard lets you configure your local host and one remote system; so that
you can perform tests and verify that the installation has been successful. In
order to create a complete production configuration, use the Configure DSA
entry.

Configure Host Links Servers
Next you must configure the Host Links servers. You can work directly on the
Gservice configuration file:
c:\gar\servers\gservice\gservice.cfg

An easier way to do this is with the Gconfig utility. From the Gmanager
Configuration menu select Gconfig:

20
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In the Gconfig utility, select the server type you want to add and click the +
button.

Refer to the user manuals for the respective server products for a complete
description of the various parameters available. When you have finished adding
servers, select File->Save to save the new configuration, and then exit Gconfig.
Note that the configuration file gservice.cfg is read by Gservice, and will
not be activated until you use Gmanager to start (or restart) the servers.

Starting the Host Links servers
You use Gmanager to start the configured servers. Just click the green start
button or select Start all servers from the Servers menu. Gmanager requests
Gservice to read the server configuration file and start the servers it finds there.
Status information for each server should now appear in the Gmanager
window:

Gallagher & Robertson
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Failure to start servers
If the configured servers do not appear in the Gmanager window then the
request to start Gservice can have failed. You can check in the task manager if
gservice.exe is running. If not, the error may have been reported in the
Windows event log. You can check by going into Settings=>Control panel,
and then in Administrative tools start the Event viewer. A common error is
that Gservice is configured with the wrong password, and gets a log on failure
reported in the System log. You must use the Gmanager Configuration menu
to enter Configure Gservice and retype the password, then use the Modify
button.

Stopping the Host Links servers
You can stop and restart individual servers from the Gmanager Servers menu,
but then the servers are restarted with the same configuration. If you have made
configuration changes you must use Gmanager to request Gservice to stop all
servers. Gservice reads the modified configuration file when you restart the
servers.
Stop the servers by clicking the red stop button or selecting Stop all servers
from the Servers menu. You will be warned that you are about to stop all
servers, and if you continue all the servers will stop.

22
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Test
Test your configuration. You will find the DSA test utility Gping useful. You
can access Gping from the Tools menu in Gmanager:

Enter the appropriate host node and application mailbox name and any other
parameters required for a connection (User ID etc.):
After a successful ping a dialog box should
pop up:

Gping can also be run from the command line as follows:
gping -li dsa:<myggatename> -dn b7dl -da iof -du jim
-pw mydogsname
Gping - $$DSA: Connected to application

For details of the test utilities please refer to the Gline manual.
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Restart Windows
Just to be on the safe side. Your installation and configuration is now complete.

SRB and manuals
The installation process installs the Software Release Bulletin in:
C:\GAR\DOC64\
C:\GAR\SRB\

WinWord format
ASCII text

The G&R Distributor package installs all of the documentation in the DOC64
directory.
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Environment
Set Host Links profiles
The profiles are used to set various parameters for customization of the Host
Links environment. This will in general not be necessary unless you have
special needs. For information on the files and the available parameters see the
section entitled Profiles configuration.

Environment variables
Some configuration can only be done using Windows environment variables
and Registry values. It isn’t possible to configure these parts using the profiles
or configuration files, as they specify where these files are and how they should
be interpreted.

PATH
If you will be running Host Links products from the command line prompt it is
recommended that you add the location of the Host Links program files to your
PATH as described in the step by step installation guide. The location is
c:\gar\bin32 by default. The PATH update will need to be done for every
Windows workstation that will be running Host Links software; it can be
changed permanently in the System Control Panel. Should you decide not to
change the PATH then it is also possible to run any Host Links program by
specifying the complete path name.

Gallagher & Robertson
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Host Links Server
Administration
Gmanager
Gmanager is the Host Links administration tool that you use to control, configure
and monitor all the G&R Host Links server programs.
The dialog and interaction between the server programs and Gmanager is based on
information located in a database file _active.srv that is located in the Host
Links servers directory. The first time a Host Links server program starts up it
registers itself in this database. Thereafter the server program updates this database
with status information whenever the server is active.
The Gmanager program is available in 2 different versions – a Windows GUI
based version gmanw.exe and a character based subset gman (UNIX/Linux
binary) or gman.exe (PC console application).
The basic functionality of the two versions is the same, but the Windows version
interfaces directly to other Windows-only Host Links administrative tools
(Gconfig, Gservice), and can also start the browser directly to view HTML
reports produced by Gproxy, if enabled, or to view the HTML pages associated
with a Gweb or Glink for Java installation.
The Gproxy reports, Gweb and Glink for Java web pages are available to
administrators of UNIX/Linux Host Links systems, and you can view them by
starting a browser manually, and connecting to the appropriate URLs:
http://mysite.mydomain.com/Gproxy
http://mysite.mydomain.com/Gweb
http://mysite.mydomain.com/GlinkJ

A summary of the available functions follows. The Windows-only functions are
marked.

Gallagher & Robertson
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Gmanager can perform the most common Host Links administrative tasks i.e.:
¾ View the last reported status information from the servers
¾ Start new server
¾ Restart a server
¾ Send a command to a server
¾ View a server log file
¾ View a server trace file
¾ Load the DSA configuration into an editor
¾ Compile the DSA configuration
¾ Call Gconfig the server configuration program (Windows)
¾ Start the configuration wizard (Windows)
¾ Load the Gservice configuration into an editor (Windows)
¾ Start the Host Links server programs using Gservice (Windows)
¾ Edit the product specific configuration files
¾ Connect directly to the Gproxy HTML pages, if enabled (Windows)
¾ Connect directly to the Gweb HTML pages, if enabled (Windows)
¾ Query the Windows printer driver about paper source capabilities
¾ View program version numbers, program link information (Windows)
¾ View license info and license usage (Windows)
¾ View Host Links environment information, the ‘VMAP’ (Windows)
A more detailed description of these functions can be found below.

28
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The Gmanager display
The following is a ‘screen shot’ of a Gmanager display showing the server
activities of a Host Links node. The marked entry shows a DSA listener
process. The other active servers in the display are: Ggate, a Gproxy process, a
Gweb server process and a Gspool server. The display shows when the server
last reported status, the actual status message and the server's directory name.

Details of the Gmanager Server display
The Gmanager screen displays all servers that have registered in the ‘active’ file.
Gmanager updates the screen is once every second, and reports the following info
per server:
¾

the date and time the server last updated the server database

¾

the server type

¾

the server home directory where the server specific log, data and
configuration files (if any) are located

¾

the ID that is used to differentiate between instances of the same server

¾

the status text describing the last reported action of the server

Use the arrow keys or the mouse to navigate to a particular server on the screen.
The highlighted server entry is now the ‘current server’ and any subsequent server
related command addresses this server only.

Gallagher & Robertson
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Taskbar functions
The following functions are available from an icon in the taskbar, as well as menu
items (mouse or accelerators):

Start/restart servers
This launches Gservice to start up all the servers defined in the Gservice
configuration file. It launches the command lines and, if successful, the
servers appear on the Gmanager server display. If the servers were already
running, it performs a restart (stop/start).

Stop servers
This launches Gservice to stop all active servers. If warn before stopping
all servers (in the Options menu) is set, it displays a new dialog box and
you must confirm the action before the Gservice stop command is issued.

Send server command
This allows you to send a command to the selected server. All the Host
Servers know and react to the following commands:
¾

DOWN - terminates the server

¾

STATUS - asks the server to report server-specific status information
to its log file

¾

PARAM - brings up a dialog box that allows the operator to give a
command line parameter to the server. Note that some parameters do
not work when given interactively i.e. they can only be handled at
server startup time

¾

DEBUG ON/OFF - all servers can toggle on and off tracing and
debugging interactively

Additionally, the server in question might support other interactive
commands. For a description of the supported commands, check the
server-specific documentation.
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View server log file.
This brings up a window with the last part of the server's log file,
displayed using the program defined in the winlister directive in the
Host Links configuration profile. If the default glistw is used, the
default action is to show the log file in update mode (new log file entries
are shown as they occur), but this can be toggled in the Options menu.

View trace/debug file
This brings up a window with the last part of the server's debug file,
displayed using the program defined in the winlister directive in the
Host Links configuration profile. If the default glistw is used, the
default action is to show the log file in update mode (new log file entries
are shown as they occur), but this can be toggled in the Options menu.
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Menu functions
The Servers menu
Start/Restart all servers
This launches Gservice to start all the servers defined in the Gservice
configuration file. It launches the command lines and, if successful, the servers
appear on the Gmanager server display. If the servers were already running, it
performs a restart (stop/start).
Stop all servers
This launches Gservice to stops all active servers.
Start new server
This brings up a dialog box that you can use to start a new server interactively.
You must enter a complete server command line.
Restart server
This restarts the selected server after a stop. It restarts with the same command
line, unless the configuration has been changed and saved.
Server command
This allows you to send a command to the selected server.
Delete server
This command deletes the selected server from the display (it will reappear if
the server is alive and continues to post status information).
Server configuration file
This brings up a window with the current server’s configuration file using the
editor configured in the wintextedit directive of the Host Links profile
(defaults to Notepad). Changes to a server's configuration file will not take
effect until the server restarts. The following server programs have their own
configuration files:
Server
DSA/DIWS listener
Gproxy
Gspool
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Stop server
This stops the selected server.
Exit
This saves the current settings (in \gar\config\system\gar.ini) and
terminates Gmanager.

The Configuration menu
Configuration wizard
This brings up a set of dialog boxes that allows the administrator to set up a
simple DSA configuration, compile the generated DSA configuration file and
optionally issue a test connection to the defined remote site. It can define the
local node, one local transport provider and one remote node.
Gconfig
This brings up the Host Links configuration program, Gconfig.
Configure DSA
This brings up the DSA configuration dialog boxes of the Host Links
configuration program.
Configure Gweb
This brings up the Gweb configuration dialog boxes of the Host Links
configuration program.
Configure Gservice
This brings up the Gservice configuration dialog box, where you can define the
Host Links user account and dependencies.

The View menu
View server logfile
This brings up a window with the last part of the selected server's log file.
View server tracefile
This brings up a new window with the selected server's trace/debug file.
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View program versions
This brings up a window containing a list of all installed Host Links programs
and each program’s creation date.
View program link details
This brings up a dialog box that asks for the name of the program you want to
review. This brings up a list of all compile units in the selected program and
each compile unit’s creation date.
View VMAP settings
This opens a window and displays the settings in the internal 'VMAP' structure.
The VMAP contains information about the Host Links environment e.g.
directories used, character sets, color attribute setting etc.
View license information
This brings up a window containing all the information in the installed license,
by license name.
View license usage
This brings up a dialog box showing license usage that allows you to choose
the license you want to review. A list-box shows all process IDs (or thread IDs)
using this license entry.
View the DSA configuration file
This brings up a window with the Host Links DSA configuration file dsa.cfg
using the editor configured in the wintextedit directive in the Host Links
profile (defaults to Notepad). This allows you to change the DSA configuration
directly but note that you must compile the file for the changes to take effect.
View the Gweb configuration file
This brings up a window with the Gweb configuration file gweb.cfg using
the editor configured in the wintextedit directive in the Host Links profile
(defaults to Notepad). This allows you to change the Gweb configuration
directly.
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View the listener configuration file
This brings up a window with the listener's configuration file config.dsa
using the editor configured in the wintextedit directive in the Host Links
profile (defaults to Notepad). This allows you to change the listener ‘on
demand’ configuration.
View the Gservice configuration file
This brings up a window with the Gservice configuration file gservice.cfg
using the editor configured in the wintextedit directive in the Host Links
profile (defaults to Notepad). This allows you to change the Gservice
configuration directly.

The Tools menu
GLCC - compile the DSA configuration file
This compiles the dsa.cfg file using glcc. The compilation reports the
result.
GDIR – the Host Links directory navigator
This starts a copy of the Host Links file and directory navigator program in a
separate window.
Gather – collect debug information
This collects comprehensive information about the Host Links installation,
including the link data of all executables, all configuration files, and all
log/trace files newer than a specified time. The information and data files are
compressed and written to dbginfo.grz in the Host Links debug directory.
This greatly simplifies reporting of problems to support.
Ggate Monitor This starts the Ggate monitor program in another window. Ggate Monitor
displays detailed information about Ggate usage. See the Ggate manual for
details.
Gspool Monitor
This starts the Gspool monitor program in another window. Gspool
Monitor displays detailed information about Gspool print spooling
operations. See the Gspool manual for details.
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Gping - Test host connection
This launches a DSA connection request to a host application using the Gping
utility. A dialog box allows you to set the DSA parameters (e.g. DSA node
name and application mailbox) necessary to reach the host application in
question. Gping reports the result of the connection request in a separate
window.
Gerror – show DSA reason code text
This brings up a dialog box that accepts a DSA reason code. It looks up the
code in the message library, and displays the corresponding error text and the
reporting communication component.
Set route state – Update TS (route) state
The DSA line handler automatically updates the state of a TS-route when
connection/disconnection events occur. This starts Gtsupd to allow you to
select a TS route and override the state, e.g. disable a TS route. Selectable states
are down, enabled, locked and used.
Print check - check availability of the printer
This starts PrtChk to check if the printer is on-line and available for printing.
Print bins - list paper sources
This starts PrtBin to request the printer driver for a list of supported paper
source names. The Windows defaults are:
auto, lower, cassette, manual envelope, envmanual,
onlyone, formsource, tractor, smallfmt, largefmt, trayn

License clean – remove dead licenses
In unusual circumstances, an instance of a product can terminate without
releasing its license. This option will check for such dead licenses and release
them. You can look at an overview of all license names installed under the
View menu item, entry License information.

The Browser menu
Gweb HTML page
If Gweb is running, this starts your default browser with the Gweb index page
(or to any HTML page configured in the Options menu).
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Gproxy HTML page
If Gproxy is running and configured to generate HTML reports this starts your
default browser with the Gproxy index page (or to any other HTML page
configured in the Options menu).
Glinkj HTML page
If the Glinkj server is running and configured to generate HTML reports this
starts your default browser with the Glinkj server index page (or to any other
HTML page configured in the Gmanager Options menu).

The Options menu
The options menu allows you to change some of the defaults.
Fonts
This brings up a dialog box that allows you to choose the font used in the
Gmanager window. It takes effect the next time Gmanager starts.
Program options
This takes you into the Gmanager configuration dialog box.
Show tools
This allows you to toggle (enable/disable) the Tool Bar.
Warn before stopping all servers
This issues a warning before stopping all servers e.g. when using the Stop All
servers function in the Tool bar or Servers menu.
List debug file in update mode
This toggles the update mode of the Glistw program. If checked, it shows
new updates to the trace file as they occur and repositions the cursor on the last
entry. Default off.
List log file in update mode
This toggles the update mode of the Glistw program. If checked, it shows
new updates to the log file as they occur and repositions the cursor on the last
entry. Default on.
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Show raw format VMAP
This toggles the display of the video map (where Host Links keeps shared
information) from a Window to a plain text listing.
Gweb options
This allows you to set another URL for Gweb. The default is:
http://XXXX/gweb/index.htm
where XXXX is the network name of the Host Links server. The actual
pathname is c:\gar\html\gweb\index.htm.
You can also set the Gweb log file to choose between the Host Links server
log, _logfile.def or the web-server log access.def.
Gproxy options
This allows you to set another URL for Gproxy. The default is:
http://XXXX/gproxy/run.htm

where XXXX is the network name of the Host Links server. The actual
pathname is c:\gar\html\gproxy\run.htm.
GlinkJS options
This allows you to set another URL for Glinkj server. The default is:
http://XXXX/glinkjs/index.htm
where XXXX is the network name of the Host Links server. The actual
pathname is c:\gar\html\gweb\index.htm.
Set desktop wallpaper
This selects the Host Links wallpaper or any wallpaper bitmap named
WALL.BMP located in the Host Links misc directory.
Reset desktop wallpaper
This resets the wallpaper to whatever was set before you used Set desktop
wallpaper.
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Server Configuration
Gconfig
The Gconfig program is an interactive Host Links configuration tool that can be
used to configure the various G&R Host Links components when they are to
run on the Windows platform. Gconfig offers the Host Links administrator an
easy-to-use GUI-menu interface for configuring all the Host Links server
programs, the GWEB product as well as the DSA network in which these
programs will operate. Gconfig minimizes the need for detailed knowledge
about the Host Links programs, the DSA objects, parameter syntax, possible
parameter values and mutual parameter dependencies. On line help is available
and this further simplifies the configuration tasks.
The server programs normally run in the background as Windows services. The
Host Links Gservice utility is used to start and stop these services.
Gservice reads a configuration file, gservice.cfg, that resides in the
Host links server directory and which holds all the server program command
lines. Gconfig is used to generate these command lines and to create and
maintain the server configuration file. Gconfig supports the following Host
Links servers:
¾

The DSA listener and line server

¾

The DIWS listener and line server

¾

The Ggate server

¾

The Gproxy network management server

¾

The Gspool network print server

¾

The GlinkJ (Glink for Java) server

¾

The GUFT server

¾

The Gweb server
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In principle, Gservice can start any program, including non-G&R programs,
and Gconfig can be used to create and maintain the commands needed in the
gservice.cfg file.
Gconfig can also be used to configure the G&R/Gweb product. The Gweb
configuration is set up in a configuration file, gweb.cfg, and resides in the
Host Links configuration default directory. A property sheet menu set
simplifies the configuration task dividing the parameters into parameter groups
and hiding the underlying configuration file structure.
Finally Gconfig can be used to configure the DSA network. The DSA
configuration is defined in a configuration file, dsa.cfg, and resides in the
Host Links configuration directory. The main DSA configuration management
menu allows you to call the DSA property sheet, to compile the configuration,
to view or manually edit the directives. Separate configuration menus for all
major DSA configuration directives are available.
A detailed description of the menus, dialog boxes and parameters of the various
Host Links components can be found below.
Gconfig is available as a Windows GUI based program and is delivered as
binary gconfigw.exe. It can be called directly from a command line or
desktop shortcut but normally it is launched from the Host Links administration
program Gmanager (see separate documentation of Gmanager).
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The Gconfig main display
The following is a snapshot of a Gconfig display showing a real configuration.
The marked entry shows a DSA/DIWS listener parameter set. The
configured servers in this sample display are the DSA listener, a Ggate
server, a GlinkJ server, a Gproxy server, a Gspool server, a GUFT server
and a Gweb server. The configuration file used here includes some
servers/command lines not supported by Gconfig. Although these programs are
unknown to Gconfig, the command lines are preserved and gathered in a
separate ‘other’ server group.
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Main functions
Server functions.
You can navigate between the server groups using the cursor keys or mouse.
The current server group is highlighted. When an action (e.g. Add Server) is
initiated, either using an icon in the task bar or via some menu item, the
program assumes that the action refers to a server of the same type as the
highlighted group, but this can be changed in the dialog list-box:
Add new server
Initiates the configuration of a new server. The configuration menus for a
server of the same type as the current group are displayed.
Delete server
Deletes the current (highlighted) server command line from the configuration
file.
Configure server
Configures the current server. The configuration menus are initialized with the
current parameter settings.
Copy server
Copies the command line of the current server. This function is useful in cases
where you want to run several servers (e.g. Gspool processes) of the same
type and the server parameters are almost identical.

Configuration menus
Whenever a server is added or modified you are led into a specific menu of
configuration options appropriate to the server. For detailed information on the
options, please consult the server manuals.

Options
Parameter dependency checking
If you set this option, the parameters you set in the configuration menus will be
checked for consistency.
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Host print in DSA networks
Print to screen session
If the mainframe application mixes print with normal screen output using print
addressing for the print blocks, and screen addressing for screen blocks the
DSA line module or Ggate simply pass print output to the client: a Host Links
emulator, Glink, or if using TNVIP or Telnet, to a third party emulator.

Print on separate session
If mainframe print output is being sent to an independent mailbox then the DSA
configuration file can be set up to merge this print session with the terminal
session. The resulting merged session looks to the client Host Links emulator,
Glink or third party emulator as if the application had used print addressing.
Please refer to the Gline manual for details of the -pco option. Alternatively a
copy of Gspool can accept the print as described below.

Gspool
If mainframe print output is being sent to an independent mailbox (a freestanding ROP printer mailbox) Gspool can be used to accept the print. Gspool
functions quite independently outside of the user process and may be
configured to connect to the mainframe, or to wait for the mainframe to connect
to Gspool. Printers configured in DPF8-S&F must log on to GCOS8. Printers
configured in RSM8 on GCOS8, in Twriter on GCOS7 and printers configured
in the SNM on GCOS6 all wait for the mainframe to connect to them. There is
no Remote Batch facility available in Host Links, so GCOS8 SYSOUT has to
be delivered to Gspool via a GCOS8 SYSOUT spooling program such as
DPF8-DS, RDF8, RSM8 or Dispatch8.
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Profiles configuration
You can use profiles to set various parameters that customize the Host Links
environment. Profile settings generally only apply to the utility programs
supplied with Host Links (such as Gdir). All PROFILES files are located in
sub-directories of the Configuration directory config located in the System
directory c:\gar\. Host Links installations all use the same user name
system. There is no user specific profile. You must place all directives in the
default or system profiles files.
Blank lines and lines beginning with an asterisk (*) are treated as comments.

Directive format
A directive begins with a keyword that identifies the command and it may have
one or more arguments. Some of the arguments are interpreted by the G&R
applications; others may be intended for an external application and therefore
passed on. The following arguments are interpreted by G&R:
Directive

Use

#A

will be expanded to the user id, i.e. the same as #U (included for
compatibility with Host Links for UNIX).

#B

expands to nothing for compatibility with the G&R/Gmail
products

#C

will be expanded to the directory path name where the user's
configuration files reside (...\config\username).

#D

will be expanded to the working directory path name.

#F

will be expanded to the full path name of the current file.

#G

will be expanded to the user's full name.

#H

will be expanded to the home directory of the user.

#I

will be expanded to the help directory.
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Directive

Use

#L

will be expanded to the language currently in use.

#M

will be expanded to nothing (included for compatibility with
Host Links for UNIX).

#N

will be expanded to the file name of the current file.

#S

will be expanded to the System Directory.

#U

will be expanded to the user id.

#V

will be expanded to workstation identification.

#Z

will be expanded to the extension part of the file name of the
current file.

#%X%

will be expanded to the contents of the environment variable X.

##

will be replaced by a single # character.

List of available directives
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Directive

Default value

CONFIGDIR

#S\config\#U

DIREDIT

#B\gedit.exe #F

DIRUSE

#S\config\default\diruse

HELPDIR

#S\help

HOMEDIR

#%HOME%

LANGKEY

none

LANGUAGE

none

LISTER

#B\glist.exe #F

MENU

ON

MISCDIR

#S\misc

SERVERDIR

#S\servers

WINLISTER

#B\glistw.exe #F
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Description of the available directives
CONFIGDIR directory – directory for user
configurations
This directive specifies the directory where all user configuration files are
stored, for example the user's PROFILES file.
Note that two special configuration files, the Default and System PROFILES
files, are stored in a fixed location under the #S\config directory. All user
PROFILES files and other configuration files, however, are stored in the
CONFIGDIR directory.

DIREDIT directive – configure editor for Gdir
With this directive you can configure the text editor to be used when you select
the 'edit file' function in Gdir. If DIREDIT is not configured, the G&R editor,
Gedit, is started.
#F will include the current file name.
DIREDIT notepad.exe #F
starts the notepad editor to edit the currently selected file.

DIRUSE pathname – user command file for Gdir
This directive specifies the name of the file containing the user commands for
the directory utility, Gdir. The default value is a file named diruse located in
your own configuration directory
...\config\username\diruse
If this file does not exist, the diruse file in the default configuration directory
...\config\default\diruse
is used. This default file is meant as an example only and should be modified.
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You may share a DIRUSE file with other users or have one or more for your
own usage. The following directive specifies that you have a DIRUSE file in
your home directory named mydiruse.
DIRUSE #H/mydiruse
You can use #A, #M and #U in the specification of the DIRUSE file.

HELPDIR directory – help base directory
The default base help directory is named HELP and is located in the System
Directory. The base help directory may be placed elsewhere with this directive.
If you enter a command in any G&R product, you may refer to the help
directory with the #I convention.
You can use #A, #M and #U in the specification of the help base directory.

HOMEDIR directory – users home directory
The default home directory for a user is the home directory defined in your file
server software. You may set a permanent home directory with this directive. If
you enter a command in any G&R product, you may refer to the home directory
with the #H convention. For example, to copy the file you are pointing at in
Gdir to the home directory using the same name you could enter the following
command:
cp #F #H
If the name of the current file is testfile and your home directory is
g:\home\peter, the above command would be expanded to
cp testfile g:\home\peter
You can use #A, #M and #U in the specification of the home directory.
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LANGUAGE ccc – configure dialogue language
Many G&R programs can operate with different languages, provided the
correct language files are installed. Two files are needed for each language, the
progtext[.ccc] and the messages[.ccc] files, located in the misc
directory subordinate to the System directory. The ccc file name extension
indicates the language to use, and corresponds to the argument to the
LANGUAGE ccc directive. The language key can be up to 3 characters long.
Default is to have no specific language key.
For example, the directive to select French program texts is
LANGUAGE FR

LISTER directive – configure file list program
Gdir uses Glist as the default to display files. If you prefer another list utility
you may configure it with the LISTER command. The default command is
LISTER #B\glist.exe #F
#B expands to nothing and #F refers to the current file. If you want to
configure the standard Windows notepad command as the file list program,
you should use the following configuration.
LISTER notepad.exe #F

MENU – display program menus
Most of the G&R applications have a menu in the upper part of the screen. By
default this menu is always displayed. If you know the G&R products well, you
may choose not to display these menus to give more room for the variable data.
You may at any time turn the menu on and off while running a G&R product
with the LF & command, independent of the default you have configured in the
PROFILES file.
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MISCDIR directory – miscellaneous file directory
This directive specifies the directory where miscellaneous files are stored.
These files are all necessary, and include character set transliteration tables
nnnn.chs, program text files progtext[.ccc] and status code explanations messages[.ccc].

SERVERDIR directory – directory for servers
This directive specifies the top directory where configuration files for the
various gateways and servers are stored. Please check the appropriate
documentation for the different servers for details.

WINLISTER directive – configure file list program
GmonitorW uses Glistw as the default to display files. If you prefer another list
utility for Windows GUI applications, you may configure it with the
WINLISTER command. The default command is
WINLISTER #B\glistw.exe #F
#B expands to nothing and #F refers to the current file. If you want to
configure the standard Windows notepad command as the file list program,
you should use the following configuration.
WINLISTER notepad.exe #F
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Sample dsa.cfg
The following file is the sample delivered with Host Links for Windows, and is
found in:
c:\gar\config\dsa.cfg

The hash characters denote comments that you can remove after the file has
been edited to reflect your site and remote nodes.
#
#
#
#
#
#
#

The Gline configuration compiler, glcc, must be run to activate any
changes made here.
The following directives are used to configure the network:
sc
- Session control
rsc
- Remote session control
ts
- Transport station
tp
- Transport provider

# For more information and sample dsa.cfg files read the Host Links
# Gline documentation. Only RFC1006 transport is supported on all
# platforms. If you need OSI-transport contact G&R.
#
#
#
#
#

RFC1006 Example
-----------------------------------------------------------Your local DSA RFC1006 node name is 'is2c'.
You want to connect with remote DSA RFC1006 node name 'ph21'
that has IP address 1.2.3.4 and 'ka01' that has 5.6.7.8

# is2c needs a dsa200 address when connecting to GCOS7
# sc is2c -addr 05:44
# Remote node GCOS8 ph21
# rsc ph21 -ts ph21_rfc
# ts ph21_rfc -class 0

-ns 1.2.3.4

-tp rfc

# Remote node GCOS7 ka01 needs a dsa 200 address
# rsc ka01 -addr 176:072 -ts ka01_rfc
# ts ka01_rfc -class 0
-ns 5.6.7.8 -tp rfc
# Use Gallagher & Robertson RFC1006 stack
# tp rfc
-who gar
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#
#
#
#
#
#
#
#
#
#
#
#

Coname configuration example
-----------------------------------------------------------See the Gline manual for information about configuring
conames and setting up filters to control access to them.
In Glink you select a coname by specifying it in the Ggate
configuration dialog box.
In Host Links a coname is selected with the '-co' parameter.
You want to use a coname 'tp8ws2' to access TP8.
It references a pool of mailbox extensions so it
can be shared by a group of users.

# coname tp8ws2 -desc "TP8 workstation 2" -pool lidpool
#
-dn ph21 -da tpws2mbx -hm dps8
# pool lidpool
#
-dx mg01
#
-dx mg02
#
-dx mg03
#
-dx mg04
# A convenient shorthand for configuring large pools:
# pool lidpool
#
-dx mg[01-04]
# conames are also used for configuration of merged print,
# where data from a separate print session is merged into the
# terminal session, marked as print data.
#
#
#
#
#
#

Merged print from TWriter on GCOS7. Use -pco to get a printer
The printer coname must wait for a connect from Twriter to
the printer mailbox mypctw.
coname mytds -desc "TDS on GCOS7"
-dn ka01 -da tdsmbx -hm dps7 -pco a2_print

# coname a2_print -desc "Twriter print to MYPCTW"
#
-ln -mn mypctw -tm a2
# end of dsa.cfg
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Marben OSIAM Stack
Delivery
We supply the Marben OSIAM transport stack, which comprises all you need
for LAN connections. For LAN connections over Ethernet and/or FDDI, the
Marben transport supports any third-party cards that use the standard Windows
NDIS interface. For X.25 WAN connections you need to purchase an X.25 card
from a dealer. Marben support the EiconCard/PC. The drivers for the card are
included in Windows server releases.
All Host Links releases from R6.1 and later require Marben release 3. If you
have an earlier release you must uninstall and upgrade.
marben301_w2k_xp.exe

Windows W2k and XP

Memory requirements
OSI stack

800 KB

X25 driver

500 KB

Plus sessions multiplied by

3KB

For a system running 200 OSI sessions the total memory consumption for the
Marben stack would amount to approximately 1.9 MB.
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Uninstalling OSIAM transport
Log in as the Host Links administrative user, gar, before you perform any of
the steps below.
Run uninstall from the MARBEN OSIAM Transport program group. It asks
you to confirm that you want to uninstall the stack. Do that. Confirm that you
want to stop the stack if it is currently running, and that you want to remove all
components.
When uninstall completes you must also remove OSI LLC Protocol driver
from the Services in the Network Control Panel. Closing the Network Control
Panel causes new bindings to be calculated and asks you to restart the
computer. When you have done that, you are ready to move on to installing the
new version of the Marben OSIAM stack.

Installing OSI stack
Log in as the Host Links administrative user, gar, before you perform any of
the steps below.
NOTE
the instructions for installing and configuring the Eicon card apply only if you
are using X.25. If you intend to use OSI over a LAN, you can skip directly to
the section entitled Installing OSIAM transport.

Installing the Eicon card
Install the Eicon card. Make sure the DIP switches on the card match a free
IRQ on your machine.

Installing Eicon driver
Start the Windows server and install the Eicon driver software. This software is
bundled with Windows server releases.
Install the Eicon card following the cards instruction. When the system boots
the system will detect the PnP Eicon Card. Follow the on screen instruction.
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Configuring the Eicon card
Start the Eicon Configuration program located in
Start->Programs-Eicon->Eicon Cards->Eicon Configuration Program
folder.
From the tree on the left, select the icon corresponding to the new Eicon card.
Double click on the icon to expand it. Select the X.25 icon under the Port.1
icon in the tree. On the right hand side of the window, change the configuration
to match your X.25 network. These parameters vary from country to country
and from one network provider to another, but the public network provider
should have given you a form describing your subscription. Use this
information to setup your Eicon driver. If you're connecting the Eicon card to a
fixed line going directly to your Datanet or MainWay, your Eicon setup must
match the setup in your Datanet/MainWay.
For a simple minimum configuration, we suggest that you use
X.25 version: 1984
Packet format: Basic (the default is: Extended).
For use with the public X.25 network in Norway (DATAPAK), you must
change the TVC (Two Way Virtual Circuits) setting.
In DATAPAK (and some other public networks in other countries), the X.25
logical group number is different from 0. In Norway it is 4, and to configure
this, we have to add 1024 to the Start TVC value. If your subscription has 12
Virtual Circuits, the Start TVC should be 1024 and the Quantity should be 12,
for 12 group-4 TVCs (ending at 1035).
It is important that the other parameters match the setting of your X.25
subscription (public network) or the Bull front-end if you are going to run
private X.25 on a fixed line to a Datanet.
Our DATAPAK subscription tells us to use:
X.25 Node type:
X.25 Window Size:
X.25 Packet Size:
X.25 TVC Start:
X.25 TVC Quantity:
HDLC Window:

DTE
2
256 (max) 128 (default)
1024
12
7

When you are done, select Save from the File menu, and then exit the program.
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Installing OSIAM Transport - step 1
Change to the temporary directory where you copied the installation files (e.g.
C:\HLINSTAL), and unpack the appropriate Marben software archive from
the command line using the –d parameter:
marben301_w2k_xp.exe -d
It will create a single directory MARBEN as a sub-directory to your temporary
directory. Change to this directory C:\HLINSTAL\MARBEN, and enter
command setup.exe. The Marben setup program will begin.
The first time you run the Marben setup program, it will inform you that you
need to install the OSI LLC driver. Click Yes to install this driver.
Follow the instructions below:
Wait for the Network and Dial-up Connections panel display, then:
i)

Right click Local Area Connection and select Properties

ii)

Choose Install, click Protocol and Choose Add...

iii)

Click the Have Disk… button, and type this set-up location (i.e.
C:\HLINSTAL\MARBEN).

iv)

Click the OSI LLC protocol OK button to install and then click CLOSE
to regenerate the network settings.

v)

After the driver installation, you must remember to reboot.

This installs the OSI LLC driver in:
\WINNT\System32\drivers\osillc.sys
\WINDOWS\System32\drivers\osillc.sys
Your server must be rebooted.
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Installing OSIAM Transport - step 2
Log in again as the Host Links administrative user, gar, change to the
temporary MARBEN directory (C:\HLINSTAL\MARBEN), and run
setup.exe again. Now you will install the main OSI-transport. Follow the
instructions in the install program.
It will prompt you for Name/Company information, destination directory
(default: C:\Program Files\MARBEN\OSIAMTransport), Program
folder (default: MARBEN OSIAM Transport) and ask you to verify your
selections before doing the installation.
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Configuring OSIAM Transport
When the installation is completed, Marben will display a dialog box, saying
‘Files downloading has been successfully performed. The package needs to be
configured now..... Click the OK button, and it presents you with a dialog box
for configuring OSI-transport. Select use X.25 and/or use LAN, depending on
which network type(s) you want to use.

Configuring OSIAM Transport for X.25
If you select use X.25, your X.25 connection might require that you enter the
machine’s local X.25 address in the Address field. Your X.25 subscription
decides your X.25 configuration. With DATAPAK in Norway, the X.25 Call
Packet Contains setting should be set to Full Local Address. In some
networks, the X.25 provider specifies the calling address, and you can
optionally provide your X.25 sub-address.
On the right hand side of the use X.25 check box, it is important that you set
the Transport Class to 2.
Set the maximum number of simultaneous connections you want the stack to
support on X.25. Note that this number influences the amount of memory
allocated for the stack. The maximum number of connections over X.25 is 850,
and the maximum number of connections on one Virtual Circuit is 126.

Configuring OSIAM Transport for LAN
If you select use LAN, there is not much to configure. Use the default setting of
TPDU size (1024) and set the maximum number of simultaneous connections
you want the stack to support on LAN. Note that this number influences the
amount of memory allocated for the stack. The maximum number of
connections over LAN is 1024. The sum of configured Ethernet connections
and X.25 connections cannot exceed 1024.
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Note that the setup program detects your Ethernet card and picked up its MAC
address. If you have multiple Ethernet cards in your PC, setup.exe will pick
up the MAC address of the first card in the binding path for the OSI LLC
driver. If you want to use a different adapter than the one currently listed as
number one, move the card you want to use to the top/front of the bindings path
for the OSI LLC driver in the Network Control Panel and rerun the setup
program from the MARBEN OSIAM Transport program folder.
Click OK to set up the OSI stack and start it as a service. When setup has
completed it will notify you that ‘Installation is successfully completed’. Click
on OK to continue.

Configuring remote nodes
It is unnecessary to pre-configure remote nodes for the Marben transport stack.
All information needed to make a connection is included in the Host Links
dsa.cfg file.
Click the OSI Configuration Help item from the G&R Software program
group to read a detailed description of remote nodes configuration in the
Marben OSI stack and Host Links dsa.cfg file. Refer also to the explanation
in the section of this manual entitled DSA network configuration, in the stepby-step installation instructions. You will find a detailed description of
dsa.cfg directives and configuration examples in the Host Links Gline
manual.

Error codes
The on-line help documents the error codes that the OSI-transport stack can
return. Click the OSI Configuration Help item from the G&R Software
program group to view the codes applicable to your release.
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Appendix: Host Links
Manuals
Below you find a complete list of all available Host Links manuals:
Installation
Host Links Servers

Installation and Configuration on UNIX/Linux

Host Links Emulators

Installation and Configuration on UNIX/Linux

Host Links

Installation and Configuration on Windows

Line handling
Gline

Line Handler and DSA/OSI Configuration

Ggate

Transparent Gateway

Gproxy

Network Manager & SNMP Proxy Agent

G&R SSL

Using SSL for security in G&R products

GlAPI

Application Programming Interfaces

Emulations
Gspool

Network Printer Emulation

GUFT

Unified File Transfer

G3270

Emulating IBM 3270 Terminals

G5250

Emulating IBM 5250 Terminals

Pthru

Gateway to the Bull Primary Network

Qsim

Emulating Questar DKU7107-7211 & VIP7700-7760

V78sim

Emulating VIP7801 & VIP7814

Gweb

Web Browser Front-end for DKU, VIP7700-7760,
VIP7800, IBM3270 and IBM5250 Emulations
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Appendix: The text library
All the messages used by Host Links are kept in the text library
progtext[.ccc] in directory gar, sub-directory misc, so the default texts
for a site can be changed using the gcptexts utility:

gcptexts - Maintain program texts
gcptexts [-v] [-x module] [-o] library [[file] [file]..]
where
<module>
<file>
Flags –x
-v
-o

<library> is progtext with all module texts
is a text module number to export, or 0 for all
are the files containing program texts to import
export, default is to import
verbose mode
overwrite ok when exporting

The host Links modules using the message library are:
Module
divutl
gdir
gedit
gline
glist
gmail
gmailer
gmenu
guft
gweb
mailutl

number for export
001
011
016
006
013
012
015
014
028
030
002

The texts are exported to one file for each module into the directory where
gcptexts is executed. The file names are fixed and the same as the module
name e.g. file ‘gline’:
#006
Attention: Do NOT modify this line!
001 You are not logged on to the gateway.
002 You are already logged on to the gateway.
003 You are not connected.
004 Already connected.
005 -LL parameter out of range.
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Procedure for modifying the library
For simplicity copy the library c:\gar\misc\progtext to a work
directory. Export the message texts you want to modify, e.g. the texts used by
Gline (module 6):
gcptexts –v –x 6 progtext

This creates the file gline in your work directory.
Modify the file (not the first line identifier) and then import the messages into
your working copy of progtext.
gcptexts –v progtext gline

You can import from multiple files using any file names, it is the first line
identifier that tells gcptexts the name of the module:
gcptexts –v progtext mygline mygweb

Take a backup copy of c:\gar\misc\progtext and replace it with your
modified version. You will need to restart the program concerned for the new
texts to be taken into use.
Note that you can have several different progtext libraries, and select the
one to be used by adding a LANGUAGE directive to the profile used by an
individual user or group of users. The libraries are identified by a suffix of up
to three characters e.g. progtext.fr, and this would be selected by adding
the directive LANGUAGE FR in the profile. See the chapter entitled Profiles
configuration for details. The default is progtext with no suffix, and if all
users speak the same language you can simply update progtext with your
translated version of the texts.
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Appendix: Error Codes
OSI/DSA error codes
Below is a list of OSI/DSA error codes and the corresponding description.
These are the same descriptions that the G&R/Gerror utility will display
when given the DSA code as a parameter.

code Description
00xx General Errors
0001
0002
0003
0004
0005
0006
0007
0008
0009
000A
000B
000C
000D
000E
000F
0010
0011
0012
0013

Open Failure in LC - Reject for unknown reason
Open Failure in LC - Acceptor customer node inoperable
Open Failure in LC - Acceptor customer node saturated.
Open Failure in LC - Acceptor mailbox unknown.
Open Failure in LC - Acceptor mailbox inoperable.
Open Failure in LC - Acceptor mailbox saturated.
Open Failure in LC - Acceptor application program saturated
Connection refused. Transport protocol error or negotiation failed.
Open Failure in LC - Dialog protocol error or negotiation failed
Open Failure in LC - Presentation protocol error or negotiation failed
Open Failure in LC / Connection refused lack of system resources
Open Failure in LC / Connection refused from GCOS7 duplicate
user
Open Failure in LC, Duplicate implicit LID / Q class not started
Open Failure in LC, Duplicate GRTS Id / lack of memory resources
Open Failure in LC, No Logical line declared for DACQ / 7
connection refused
Open Failure in LC, GCOS 8 GW Missing translation / Incorrect
device length in ILCRL.
Open Failure in LC, DAC connection not initialized / Too many jobs
executing
Open Failure in LC, No binary transfer / impossible to start the IOF
job
Open Failure in LC, connection is not negotiated in FD mode /
impossible to start the IOF job
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0014
0016
0017
0018
0019
001A
001B
001C
001D
001F
0020
0021
0022
0023
0024
0030
0031
0033
0039
003C
003E
003F
0040
0041
0042
0044
0045
0047
004F
0050
0051
0052
0053
0054
0055
0056
0057

66

Disconnection - Timeout resulting from absence of traffic.
Option missing for an RBF mailbox.
Connection refused - Incorrect access right for MB.
Connection refused - Incorrect access rights for the application.
Connection refused - Unknown pre-negotiated message path
Connection refused - Security validation failed.
Connection refused - Unknown acceptor mailbox extension.
Connection refused - Inoperable acceptor mailbox extension.
Connection refused - Invalid Message group number.
Disconnection - no more memory space.
Connection refused - Unknown node.
Connection refused - inaccessible node or Host down.
Connection refused - saturated site.
Connection refused - inoperable mailbox.
(X.25) Packet too long. Problem with packet size. / Connection
block already used.
Syntax Error - option not known (received on close VC).
(X.25) No response to call request packet - timer expired.
(X.25) Timer expired for reset or clear indication.
Disconnection - transport protocol error (MUX).
Presentation Control Protocol Error
The application has not the turn
Message group closed
(X.25) Facility code not allowed. / Connection refused - unknown
node
Connection refused - path not available.
Connection refused - Duplicate USER ID / Facility parameter not
allowed
(X.25) Invalid calling address.
(X.25) Invalid facility length.
(X.25) No logical channel available.
DNSC: (X.25) Invalid call packet length.
Normal disconnection (GCOS3/8)
Error or Event on LC initiated by GW
Error or Event on LC initiated by GW.
Error or Event on LC initiated by GW. TCall
Error or Event on LC initiated by GW. DIA in LOCK State
Error or Event on LC initiated by GW. DIA error
Error or Event on LC initiated by GW. GW has no known
explanation.
Error or Event on LC initiated by GW. Reject mailbox permanent
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0058
0059
005A
005B
005C
005D
005E
005F
0060
0061
0062
0064
0065
0066
0067
0068
0069
006A
006B
006C
006D
0078
0079
007F
0081
0082
0083
0085
0086
0087
0090
0092
0093

Error or Event on LC initiated by GW. No more input lines in
DACQ
Time-out on GCOS 3/8 gateway.
Error or Event on LC initiated by GW. Disconnect from terminal
without reason
Error or Event on LC initiated by GW. Wrong letter or wrong record
Error or Event on LC initiated by GW. Forbidden letter received
Error or Event on LC initiated by GW. Forbidden letter received
Error or Event on LC initiated by GW. No buffer for secondary letter
Error or Event on LC initiated by GW. No buffer for fragmented
letter
Error or Event on LC initiated by GW. Disconnect on end of phase
record
Error or event on LC initiated by GW. No buffer for control letter.
Error or event on LC initiated by GW. Mailbox in closing phase
Error or event on LC initiated by GW. Flow control error.
Error or event on LC initiated by GW. CH locked by operator.
Error or event on LC initiated by GW. Disconnect with a normal
TMG F2 exchange.
Error or event on LC initiated by GW. Teletel rerouting error from
DACQ
Error or event on LC initiated by GW. Teletel routing error from
DACQ
Error or event on LC initiated by GW. Teletel rerouting error from
TM
Error or event on LC initiated by GW. Teletel rerouting error from
TM
Syntax error - text too long.
Syntax error - illegal object in a GA command.
Syntax error - unknown node Id.
Syntax error - illegal command for this object.
Syntax error - illegal date.
(X.25) No route available for X.25 switching.
No more network routes available for switching.
(X.25) Hop count reached for X.25 switching.
(X.25) Flow control negotiation error.
(X.25) Frame level disconnection.
(X.25) Frame level connection.
(X.25) Frame level reset.
Frame level not set.
(X.25) X.25 Echo service in use.
(X.25) Incorrect password for PAD connection.
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0094
0096
009C
009D
009E
009F
00B2
00B6
00C0
00D7
00DE
00E1
00E6

(X.25) No more PAD connections allowed.
(X.25) TS SX25 or NU X25 objects locked.
(X.25) Invalid packet header. X.25 protocol error.
(X.25) Incompatible header. X.25 protocol error.
(X.25) Logical Channel Number too high.
(X.25) Incorrect packet type.
Use of invalid password through PAD
Unknown mailbox selection for PAD connection using the PAD
password.
(X.25) Normal disconnection.
(X.25) TS image (of type DSA or DIWS) in LOCK state.
(X.25) NS RMT or NR SW in LOCK state.
Connection refused. Mailbox is not in ENBL state.
QOS not available permanently.

01xx Session Control
0100
0101
0102
0103
0104
0105
0106
0107
0108
0109
010A
010B
010C
010D
010E
010F
0110
0111
0112
0113
0115
0117
0118
0119
011A
011E
68

Logical connection accepted or normal termination
Rejection for unknown reason or abnormal termination
Acceptor node inoperable.
Acceptor node saturated. When a node has no available resources
Acceptor mailbox unknown.
Acceptor mailbox inoperable.
DNS: Acceptor mailbox saturated.
DNS: Acceptor application program saturated.
Transport protocol error or negotiation failed (DSA 200 only).
Dialog protocol error or negotiation failed. (Wrong logical record).
Time-out on session initiation / unknown LID
Acceptor mailbox extension unknown.
Acceptor mailbox extension inoperable.
Invalid Session Number.
Unknown node.
System error. System generation error or insufficient memory space
Application abnormal termination. Subsequent to an abnormal
occurrence in the dialogue
Normal terminate rejected.
Protocol not supported.
Session control service purged by user.
Disconnection Time-out on message group initiation.
Incorrect Access Right for MB
Incorrect Access Right for the Application
Pre-negotiated Message Path Descriptor unknown
Security validation failed
Incorrect object status
Host Links Installation and Configuration
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011F
0120
0121
0122
0123
0124
0125
0126
0127
0128
0129
012B
012C
012D
012E
012F
0130
0131
0132
0133
0134
013C
013E
013F
0140
0151
0152
0153
0154
0156
0157
0158
0159
015A
015B
015C
015D
0160
0161

Not enough memory space available.
Node unknown.
The channel object (CH) is in LOCK state
Saturation - no plug available
Object status = LOCK
Connection block (TSCNX) already used
Disconnection already running
The connection block (TSCNX) is disconnected (or not connected)
Change Credit value < 0
Ineffective Change Credit ( delta = 0 )
No more deferred letters
"Reinitialization" Request
"Reinitialization" in progress
"Reinitialization" in progress, letters are dropped
Close virtual circuit. Either no mapping exists between PA/NR or
CL and VC/NS
Null connection object index.
Undefined function at Sysgen time.
Letter too large with respect to the negotiated size.
The received letter is longer than the size which was
Disconnection of the session control user
Interface error on EOR (End-Of-Record) processing.
Presentation control protocol error.
You do not have the turn.
Message group closed.
Session is closed.
Request refused, no system buffers available.
Incorrect addressing record.
No presentation record in the ILCAL or ILCRL
Negotiation failed on session mode
Negotiation failed on resynchronization.
Negotiation failed on END to END ACK
No presentation record in the connection letter
Negotiation failed on session mode
Negotiation failed on letter size (in the Logical Connection record).
Negotiation failed on resynchronization (in the Logical Connection
record).
Negotiation failed on end-to-end ACK (Logical Connection record).
No support of the "letter" interface because Multirecord is not
negotiated.
Incorrect TSPACNX table.
Protocol error on letter reception.
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0162
0163
0164
0165
0166
0167
0168
0169
016A
016B
016C
016D
016E
016F
0170
0171
0172
0173
0174
0175
0176
0177
0178
0179
017A
017B
017C
017D
017E
017F
0180
0181
0182
0190
0191
0192
0193
0194
0195
0196
0197
0198
70

Negotiation failure.
Record header length error.
Protocol error.
Protocol error reception of control letter.
Type or length error on interrupt letter.
Protocol error on reception of data letter.
Dialog protocol error.
Unknown event.
Protocol error on data transfer.
Invalid status for a disconnection request.
Invalid status for a recover
Invalid status for a suspend/resume request.
Negotiation failure.
Unknown command.
Error in presentation protocol
Letter header length error in
ILCAL is not DSA 200 protocol.
Error in session record.
Normal disconnection, without complementary reason code.
Letter is not in ASCII or EBCD.
Connection protocol letter header
Letter header protocol error.
Record header protocol error.
Record header length error.
Mbx record header length error.
Error on buffer transfer.
DSA 200 record header protocol
DSA 300 record header protocol
Unsupported connection options.
Character error in ASCII string.
No segmented record size.
Invalid mailbox object index.
Mapping error for a remote connection.
No more buffers.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
No more buffers.
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0199
019A
019B
019C
019D
019E
019F
01A0
01A1
01A2
01A3
01A4
01A5
01A6
01A7
01A8
01A9
01AA
01AB
01AC
01C0
01C1
01C2
01C3
01E0
01E1
01E2
01E3
01E4
01E8
01E9
01EA
01EB
01EC

Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Byte count is greater than GP.
Invalid transfer state.
Suspend protocol running.
Suspend protocol running.
Recover protocol running.
Forbidden function in write request. ($WRITE)
Conflicting parameters for segmented record. (SWBREC)
Protocol conflict - suspend/recover.
Protocol not supported - letter/end-to-end ACK. (SWBLET)
Multi-record letter in progress.
Interrupt request forbidden.
Send control record request forbidden. (SCTROL)
Forbidden for TWA session - turn is here. (SREAD)
Termination forbidden - suspend or recover in progress. (STERM)
No space available for downstream connection request. (SMECNX)
No space available for upstream connection request. (SMUCNX)
No space available for upstream SCF connection. (SMRCNX)
No space available for session context. ($SCTX)
Enclosure or data length error for a write request. ($WRITE)
Enclosure or data length error for a write segment record request.
(SWBREC)
Enclosure error for 'give turn' request. (SGVTRN)
Interrupt request is not demand turn, attention/data attention, or
purge record.
Input status for a send control letter is not permitted.
Write request without turn.
Write segmented record request without turn.
Write segmented letter request without turn.
Send control letter request without turn.
Disconnection request without turn.

02xx Presentation Control
0201
0202
0203
0204

Protocol level not supported
Application designation protocol error.
Character encoding error. TM cannot support the proposed encoding.
Character set error. TM cannot support the proposed character set.
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0205
0206
0207
0230
0231
0232
0233
0234
0235
0236
0237

Character subset error. TM cannot support the proposed character
subset.
Incorrect record encoding.
Incorrect parameter encoding.
Data presentation control error. The presentation control proposed
for this session cannot be used
Device type is incompatible with the configuration.
TM control protocol is incorrect.
Device-sharing attributes are invalid.
Initiator or acceptor configuration is not correct.
Logical device index error.
Number of logical devices is incompatible with the configuration.
TM protocol record not supported.

03xx Terminal Management
0300
0301
0302
0303
0304
0305
0306
0307
030A
0310
031E
0320
0321
0322
0323
0324
0325
0326
0327
0328
0329
032A
032B
032C
72

Sysgen error WARNING. There is no mapped object; some objects
will be spare.
Operator requested session abort or logged.
Idle time run out after secondary network failure.
Idle time run out for no traffic.
Form not found.
Operator requested suspension.
Destructive attention send on the session.
Unknown TX addressed in this session. TM is unable to a the
session.
Protocol error. A record was received which did not comply with
current standards
Insufficient resources. The receiver cannot act on the request
because of a temporary
Incorrect value for Retry or Wait parameters on UP LL command.
Function not supported.
Parameter error. This can result
Resource not available. The
Intervention required (on principal device).
Request not executable.
EOI required.
Presentation space altered, request executed.
Presentation space altered, request not executed.
Presentation space integrity lost.
Device busy. The device is busy and cannot execute the request.
Device disconnected.
Resource not configured.
Symbol set not loaded.
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032D
032E
0330
0331
0332
0340
0341
0342
0343
0344
0345
0346
0347
0348
0349
034A
0350
0360
0361
0362
0370
0371
0372
0373
0374
0375
0376
0380
0381
0382
0383
0384
038C
0390
0391
0392
03C0

Read partition state error.
Page overflow.
Subsidiary device temporarily not available.
Intervention required at subsidiary device.
Request not executable because of subsidiary device.
TM cannot accept a new connection.
Object status incorrect.
The TM configuration is not correct.
Unknown TX addressed on this session.
Data presentation protocol error.
Device type is incompatible with the configuration, or is not
supported.
TM control protocol incorrect.
Device shareability attributes are invalid.
Initiator or acceptor configuration is not correct.
Logical device index error.
Number of logical devices incompatible with the configuration.
Disconnection of TM after reinitialization of the network.
File not found. (Welcome and Broadcast Messages)
Site not found. (Welcome and Broadcast Messages)
NASF error. (Welcome and Broadcast Messages)
No-session timeout. Device disconnected.
No-input timeout. Device disconnected.
No-output timeout. Device disconnected.
Timeout due to no backup session being initiated.
Timeout due to no backup session being established.
Connection refused because of late activation of back up session.
Disconnection of current session to switch to backup session.
AUTOCN parameter not declared.
Mixed ETB in data sent by VIP screen and cassette
Data header sent by the terminal incorrect.
Desynchronization in the exchange of data.
KDS block count error.
Remote terminal is not connected
Unknown mailbox.
No call packet to return.
No "Possibility" command to return Protocol error
Slave device disconnection.

17xx Network Layer
1701
1702

PAD connection refused.
Flow control error.
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1706
1707
1708
1709
1710
1711
1712
1713
1714
1717
1718
1719
171A
171B
171C
171E
171F
1721
1723
1724
1725
1726
1727
1729
1731
1732
1733
1740
1741
1742
1744
1745
1747
1749
174F
1755
74

Logical channel number not zero in restart packet.
Illegal packet length or use of D-bit forbidden.
Illegal header.
Illegal Logical Channel Number.
Invalid packet type for the automaton state. Protocol error
Incorrect packet type.
Inconsistent network parameters in the generation file.
No more space.
DSAC network layer object not usable.
USED/ENBL transition. Transport station is locked.
USED/ENBL transition. This is a back-up NR.
USED/ENBL transition. Dynamic close due to load.
USED/ENBL transition. Transfer time-out has elapsed.
USED/ENBL transition. This is a back-up NR.
USED/ENBL transition. Transport station is idle.
USED/ENBL transition. NR object is locked.
ENBL/LOCK transition. NR HDLC has no more memory space.
Remote station is inaccessible via the configured network. Check
Incorrect PAD password.
Virtual circuit already in use. LCN (Logical Channel Number) too
high.
Invalid virtual circuit.
Packet too short. Protocol error for the equipment directly connected
to the Bull Datanet.
Incompatibility between the generation parameters of two
communicating systems on window or packet size.
Packet size in communicating systems not the same.
Timer runs out while waiting for call confirmation.
Timer runs out while waiting for clear confirmation.
Timer has run out while waiting a reset confirm.
Call setup or call clearing problem.
Open failure on virtual circuit. No flow control on this NS.
Incorrect facility. Protocol error for the equipment directly
connected to the Bull Datanet.
Unknown subscriber.
End of time-out on reset confirm. Invalid facility length. Protocol
error for the equipment directly
No logical channel available.
End of time-out on call confirm.
Incorrect packet length. Protocol error for the equipment directly
connected to the Bull Datanet.
Flow control, window, packet size or reset error.
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1760
1770
1771
1781
1782
1783
1785
1786
1787
1790
1791
1792
1793
1794
1795
179B
179D
179E
179F
17A0
17B0
17B1
17B2
17B3
17B4
17B5
17B6
17B8
17B9
17CB
17CC
17CE
17CF
17D0
17D4
17D7
17DD
17DE
17DF
17E0
17E1
17E2

Frame disconnection.
Frame connection.
Frame reset.
No more network routes available for X.25 switching.
Maximum of 15 switches have been used,
Flow control negotiation error.
Frame level disconnection.
Frame level connection.
Frame level reset.
Frame level not established.
No more logical paths available for the PAD.
Echo service busy.
Incorrect PAD password.
All the PAD virtual circuits are used
X.25 initialization not possible.
LCN not null in restart packet
Incompatible header (receive error: all VC of concerned NS
LCN greater than NBVC in NS directive
Incorrect packet type
Invalid facility.
Normal disconnection.
X.25 Echo in use.
No more logical channels available.
No more PAD connections allowed.
TS SX25 or NU X25 object locked.
Buffer capacity overflow.
Normal disconnection.
Unknown calling SNPA (Sub-Network Point of Attachment).
Internet problem.
Call collision on VC
Incompatible generations (NR object without mapping).
Invalid status NR locked.
Lack of space.
Unknown subscriber.
TSCNX already used for another connection. SCF internal error.
Transport station locked.
Proper NS locked.
Invalid status NR locked.
Lack of space.
Forbidden parameter or invalid value.
Invalid transition.
Upward-mapped object (TS) not locked.
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17E3
17E4
17E5
17E6
17E7
17E9
17EB
17EE
17FF

No object mapped above.
NR not locked (MP NR -ADD/-SUB) or virtual circuit already open.
NR is last in list and the TS is not locked.
No object mapped above (UP NR -PRIO). NR not mapped on TS.
Upward mapped object not locked
Mix of datagram and connection network
Class inconsistent with NR.
Incompatible generations. NR object without mapping.
Wrong parameter in administrative CALL

18xx Transport Layer
1800
1801
1802
1803
1804
1805
1806
1807
1808
1809
180A
180B
180C
1817
181F
1821
1824
182E
182F
1831
1832
1833
1834
1835
183A
183C
1840
76

Normal disconnection initiated by the correspondent
Local saturation at connection request time.
Failed negotiation at connection time.
Duplicate connection. Two or more requests have been issued for the
same connection.
Redundant request.
Retransmission Time-out at transport level.
Survey time-out at transport level.
Transport protocol error.
Session Control specified is not available (inaccessible).
Requested Session Control Id unknown by remote transport.
Termination because of disconnection by administration.
Session Control/Transport interface error.
Connection request on non-sharable VC in case of ISO Transport.
ISO: header or parameter length is invalid.
Station in shut-down state.
No memory space at connection time.
Session Control inaccessible by configured session routes. ISO:
Session entity not attached to TSAP.
Collision between Close NC and Open TC.
Remote station not configured.
Resource saturation.
ISO: No route for the called NSAP.
ISO: Received NSAP addresses are wrong.
Segmentation violation.
ISO:QOS priority not available temporarily, due to a local condition
(for example, lack of resources).
ISO:QOS priority permanently unavailable locally (for example, due
to an error in the system generation).
ISO: Remote reason not specified.
ISO: Remote transport entity congestion at connect request time.
Server in terminating state. TC has been re-assigned on another NC.
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18A1
18B0
18EF

An additional NC has been assigned to a TC.
NC has been re-assigned on another VC.
Disconnection at Transport level caused by reception of RESTART
DSA during the transfer phase.

Windows Sockets error Codes
Below is a list of Windows Sockets return codes and the corresponding
description.
Hex
code
2714

Windows Sockets Access
Error name
WSAEINTR

2719
271E

WSAEBADF
WSAEFAULT

2726

WSAEINVAL

2728

WSAEMFILE

2733

WSAEWOULDBLOCK

2734

WSAEINPROGRESS

2735

WSAEALREADY

2736
2737
2738

WSAENOTSOCK
WSAEDESTADDRREQ
WSAEMSGSIZE

2739

WSAEPROTOTYPE

273A

WSAENOPROTOOPT

273B

WSAEPROTONOSUPPORT
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Description
The (blocking) call was cancelled
via WSACancelBlockingCall()
The socket descriptor is not valid.
An invalid argument was supplied
to the Windows Sockets API.
An invalid call was made to the
Windows Sockets API.
No more file descriptors are
available.
The socket is marked as nonblocking and no connections are
present to be accepted.
A blocking Windows Sockets call
is in progress.
The asynchronous routine being
cancelled has already completed.
The descriptor is not a socket.
A destination address is required.
The datagram was too large to fit
into the specified buffer and was
truncated.
The specified protocol is the wrong
type for this socket.
The option is unknown or
unsupported.
The specified protocol is not
supported.
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273C

WSAESOCKTNOSUPPORT

273D

WSAEOPNOTSUPP

273E
273F

WSAEPFNOSUPPORT
WSAEAFNOSUPPORT

2740

WSAEADDRINUSE

2741

WSAEADDRNOTAVAIL

2742

WSAENETDOWN

2743

WSAENETUNREACH

2744

WSAENETRESET

2745
2746
2747

WSAECONNABORTED
WSAECONNRESET
WSAENOBUFS

2748
2749
274A
274B
274C

WSAEISCONN
WSAENOTCONN
WSAESHUTDOWN
WSAETOOMANYREFS
WSAETIMEDOUT

274D

WSAECONNREFUSED

274E

WSAELOOP

274F
2750
2751

WSAENAMETOOLONG
WSAEHOSTDOWN
WSAEHOSTUNREACH

The specified socket type is not
supported in this address family.
The referenced socket is not a type
that supports connection-oriented
service.
The specified address family is not
supported by this protocol.
The specified address is already in
use.
The specified address is not
available from the local machine.
The Windows Sockets
implementation has detected that
the network subsystem has failed.
The network address can't be
reached from this host. There is
probably a problem in the way you
have set up TCP/IP routing for your
PC (most likely you have not
defined a default router).
The connection must be reset
because the Windows Sockets
implementation dropped it.
The connection has been closed.
Not enough buffers available, or
too many connections.
The socket is already connected.
The socket is not connected.
The socket has been shutdown.
Attempt to connect timed out
without establishing a connection.
The attempt to connect was
forcefully rejected. The service on
the other side is not available.
Too many symbolic links were
encountered in translating the path
name.
The host machine is out of service.
The host machine is unreachable.
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2752
2753
2754
2755
2756
2757
276B

WSAENOTEMPTY
WSAEPROCLIM
WSAEUSERS
WSAEDQUOT
WSAESTALE
WSAEREMOTE
WSASYSNOTREADY

276C

WSAVERNOTSUPPORTED

276D

WSANOTINITIALISED

2AF9

WSAHOST_NOT_FOUND

2AFA

WSATRY_AGAIN

2AFB

WSANO_RECOVERY

2AFC

WSANO_DATA
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Indicates that the underlying
network subsystem is not ready for
network communication.
The version of Windows Sockets
API support requested is not
provided by this particular
Windows Sockets implementation.
A successful WSAStartup() must
occur before using this API.
Authoritative answer host not
found.
Non-authoritative answer host not
found, or SERVERFAIL.
Non-recoverable errors,
FORMERR, REFUSED, NOTIMP.
Valid name, no data record of
requested type.
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